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User’s Guide

Introduction

	 \definition "Section 403(b) plans" 
	Millions and millions of Americans participate in Section 403(b) plans. Not all of these participants require help in determining contribution limits, since many are interested in setting aside only modest funds.  But others, particularly those approaching retirement, along with higher-paid administrators and other professionals, may wish to set aside the maximum permissible amount.


Meanwhile, the IRS continues to audit 403(b) plans rather aggressively, and contributions are a main focus.  And despite tax law changes that have significantly liberalized and simplified rules surrounding 403(b) contributions, there remain some traps for the unwary as well as opportunities for the alert.  Under the new regulations starting in 2009, compliance is even more important.

	No computer program, including this one, should be considered a substitute for a professional tax adviser, of course!
	This is where the 403(b) Contribution Planner® can save the day.  By asking the right questions and then performing the right calculations, the system can help assure that contributions are as high as possible without being more than permitted.


Among the variations the 403(b) Contribution Planner® can handle:

· Performs calculations for either salary reduction or employer-pay-all plans \Relate "HELP403.DOC!126", "Performs calculations for either salary reduction or employer-pay-all plans" , as well as for combination plans where the employer pays a fixed dollar amount, a fixed percentage of gross compensation, or matches a percentage of employee contributions.

· Is fully up-to-date, but can also calculate pre-2002 cases using the old rules, in case you are dealing with an audit.

· Takes care of special adjustments for participants who work part-time or a partial year.

· Performs aggregation with other Defined Contribution plans when required, including plans offered by other employers or through self-employment (e.g. a doctor who works for a hospital but also has a private practice, or a university professor with outside income from consulting or book publishing).

· Offers many important side calculations, including estimates of state retirement plan benefits, analysis of buyback options, paycheck comparison, required minimum distributions, 72(t) distributions, and more!

· Helps optimize contributions between traditional pre-tax and the newly authorized Roth contributions options (in most versions of the system).

The reports produced by the system will explain all the variations in the calcs, if you wish.  You can request a bare summary of the contribution limits, a summary supplemented by a brief commentary, or the results plus the commentary plus notes that refer to specific Internal Revenue Code sections and IRS Regulations and that explain in detail how the calculations were made.  In our current environment of tight compliance and high concern on the part of plan sponsors, the power of the 403(b) Contribution Planner to justify its answers is a key benefit.

Installation

Hardware and software requirements

The 403(b) Contribution Planner® will run on any machine that supports Windows programs.  The system requires roughly 8 megabytes of disk space, about one-third of which is for files in your Windows \SYSTEM directory, some or all of which you may already have.  The files installed into your \403 directory comprise about 6 megabytes, excluding the Batch Processing Utility.

Installation procedures

To install the system:

· run the setup program, and follow the simple instructions on the screen

· the first time you run the system you will be asked to review and accept the license agreement; if you do not accept the agreement, you may click the "Reject" option, and return the system to your provider.

Configuring the System
(not available in all versions)

The first time you enter the system, you may want to try clicking the "Configuration" item on the main menu bar, if it is available in your version.  Here you can enter your name, or the name of the organization you represent, so that it will appear on all the participant reports you print.  There are some other settings on the Configuration screen that you may also wish to use.

Installing a new version of the system will not wipe out your existing client data files!

Overview

What it does

The 403(b) Contribution Planner®:

· lets you input information about the participant, the participant’s employment, and the participant’s benefit plans, including the 403(b) plan in question;

· calculates and displays \Relate "HELP403.DOC!37", "calculates and displays"  the maximum permissible contribution for the specified tax year; if the participant is eligible for any alternative/catchup provisions (mainly for years prior to 2002 — only the special church limit still applies after 2001), each of these is displayed as well;

· produces a printed report \Relate "HELP403.DOC!39", "produces a printed report"  with a summary of the results, plus, if you choose to include them, detailed explanations; output can be sent to a text file instead of the printer, if you prefer;

· allows you to save the data \Relate "HELP403.DOC!31", "save the data"  you input, so that you can re-run it later, or so that you can update it the next year without having to input again from scratch.

In addition, most versions of the system provide supplementary functions, including the ability to update the table \Relate "HELP403.DOC!171", "update the table"  that contains the key inflation-adjusted IRS limits, the option to print an input form, the ability to print a report containing the calculation assumptions you input \Relate "HELP403.DOC!3", "print an input form" , and a facility to easily delete obsolete participant data files \Relate "HELP403.DOC!32", "delete obsolete participant data files" .  Most versions also include a Retirement Planning calculation and presentation, Required Minimum Distributions and 72(t) distribution calculations, a Section 457 plan contribution calculator, a State Retirement Plan Benefit calculator, an evaluator for service credit Buybacks under state plans, an Asset Accumulation illustration, and a Paycheck Comparison screen and report.  There is also a "Wizard" to help decide clients decide which kind(s) of tax-advantaged plan should receive their contributions.

How the system is organized

The 403(b) Contribution Planner® is set up mainly to do “live” calculations: you enter the pertinent information, run the calculation, print the report, and you’re done.

However, you can also save your inputs in permanent files \Relate "HELP403.DOC!31", "save your inputs in permanent files" , enabling you to re-run a case without re-inputting everything from scratch.  You can also save data from year to year and update the same participant’s results annually with a minimum of new input.

	TIP: Give your participant data files names that will suggest who they’re for.  You can use long file names to make your data listings more self-explanatory.
	These permanent participant files are standard ASCII files, although you shouldn’t try to edit them manually, since they follow a very particular format.  By default, the files are given a filename extension of .403 (e.g., MYFILE.403), in the directory in which you run the program (by default, the \403 directory).  However, you can give your files any legitimate file name, and save them in any directory on any drive, including a floppy drive.  You can also copy your files from one drive to another, or even to another machine where you have the 403(b) Contribution Planner® installed.  If you also use Still River's RetirementWorks® system, you can share files between the two (RetirementWorks® uses files with a .QPD filename extension).


You also have flexibility with output.  Although the system is geared toward printing your output in real time, you can, if you wish, print to an ASCII text file \Relate "HELP403.DOC!48", "print to an ASCII text file" .  By default, text files are given a .TXT or .RTF extension and reside in your \403 directory, although you can change these specifications, too.  Then, if you like, you can load these files into a word processor so that you can edit them or make them part of a larger presentation.

	TIP: Check the on-line Help, too.  Much more detail is included on-line than appears in the printed guide. \definition "If you run into problems" 
	Apart from that there’s not much you need to know about the physical workings of the system.  If you run into problems, consult the Common Questions and Problems \Relate "HELP403.DOC!174", "Common Questions and Problems"  section of this guide.


How the system works

	see: Running a sample case, starting on page 8.
	Here are the essentials.  There are more specifics in the next section.


Start up the system...

...by clicking the 403(b) icon on your desktop.

Get into run mode...

...by clicking the Run Calculations and Reports button \Relate "HELP403.DOC!0", "Run Calculations and Reports button"  on the Main Options screen \Relate "HELP403.DOC!6", "Main Options screen" .  In some versions of the system, you can select either an Advanced or a  Basic input mode \Relate "HELP403.DOC!236", "input mode" .  The Basic mode omits several input fields present in the Advanced mode.  The Basic Mode is adequate for the large majority of 403(b) participants, but the Advanced mode is available for the exceptions.

Follow the numbered sequence...

...on the Run Calculations and Reports screen \Relate "HELP403.DOC!17", "Run Calculations and Reports screen" :

· button #1 takes you to the Open Participant Data File screen \Relate "HELP403.DOC!24", "Open Participant Data File screen" , where you can load an existing participant file or clear the input fields for a brand new participant.

· button #2 takes you to the Participant and Employer Information screen \Relate "HELP403.DOC!52", "Participant and Employer Information screen" , and from there to its related screens if you need them, so that you can enter information about this participant’s employment.

· button #3 takes you to the Benefit Plans screen \Relate "HELP403.DOC!108", "Benefit Plans screen" , where you can enter data about this 403(b) plan as well as other Defined Contribution plans and/or Defined Benefit plans this participant belongs to.

· button #4, now that data input is completed, launches a calculation and takes you to the Summary of Options screen \Relate "HELP403.DOC!37", "Summary of Recommendations screen" , where the results are displayed and from which you can request a preview and/or print of a written report on the results.

· button #5 saves the participant data \Relate "HELP403.DOC!22", "saves the participant data"  for you.

· button #6 returns you to the Main Options screen \Relate "HELP403.DOC!6", "Main Options screen" , or you can go directly back to button #1 to start up another participant.

Running a sample case

You could probably use the 403(b) Contribution Planner® effectively just by starting it up and doing what comes naturally.  But taking the time to walk through the sample case provided when you install the system, and illustrated below, will give you a head start.

The sample case is not the most complex that could be devised, nor is it the simplest.  It’s structured to show you some of the nice features of the system.  But there are entire screens that do not show in this sample — you’ll see them, though, if you need them when running your own cases.

To start the system

All you have to do is double click on the 403(b) icon.  The Main Options screen \Relate "HELP403.DOC!6", "Main Options screen"  will come into view.  It contains our copyright notice, and offers you several buttons that take you directly to some key functions.  This screen is illustrated on the following page.

Don’t forget to consult the on-line Help — often!  Unexpected IRS oddities are documented for the fields they affect.  Click on (or Tab to) the field you want, then press the F1 key.

The input sheet

You don’t have to use our input form, particularly if you have one of your own you are used to.  The advantage of using the one in the system is that it flows the same way the system’s screens do, so that it makes data input more efficient.
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	If you do decide to use it, you can get one or more copies simply by clicking on the Print Input Form button \Relate "HELP403.DOC!3", "Print Input Form button"  on the Main Options screen \Relate "HELP403.DOC!6", "Main Options screen" .  You will be asked how many copies you want.  Enter the correct number, click OK, and the forms you want will print.  Or, just print one copy, and photocopy all the extras you want!  If your version of the system allows the Basic Input mode, you can print input forms for Basic or Advanced mode, or both.


Figure 1: Main Options screen
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Starting the run
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	When you’re ready to run the case, start up the program.  From the Main Options screen \Relate "HELP403.DOC!6", "Main Options screen" , select the Run Calculations and Reports button \Relate "HELP403.DOC!0", "Run Calculations and Reports button" .  This is the button that will take you to all the functions essential to running a case.

	Other screens that offer the Menu Bar: the Run Calculations and Reports screen; the Participant and Employer Information screen; the Benefit Plans screen; and the Summary of Recommendations screen
	In addition, the Main Options screen \Relate "HELP403.DOC!6", "Main Options screen"  and a few of the other major screens show the menu bar \Relate "HELP403.DOC!5", "menu bar"  with File, Print, Configuration, Tools, Window, and Help menu items.  The File menu option \Relate "HELP403.DOC!9", "File menu option" , as in most Windows programs, allows you to perform basic file maintenance and printing functions, or exit the program.  The Print menu option \Relate "HELP403.DOC!10", "Print menu option"  is for printing or previewing participant reports or input forms \Relate "HELP403.DOC!39", "Print Utility screen" .  The Configuration option takes you to the Configuration screen.  Tools lets you use any special utilities available in your version of the system.  The Window item allows you to jump directly to almost any other screen in the system.  Clicking the Help menu option \Relate "HELP403.DOC!11", "Help menu option"  pops up the 403(b) Contribution Planner® on-line Help facility.  As you will learn in using the system, there are also other ways to get to these functions.  The Special Calculations buttons on the right take you to an input screen for the calculation you select.


If your version of the system offers Basic Input mode, click on "switch to ADVANCED Input Mode" near the bottom of the screen, so that your screens will most closely match those illustrated.  BASIC input mode is very similar, except that certain input fields made are invisible to you so that you are not distracted by them..

But for now, just click the Run Calculations and Reports button.

Figure 2: Run Calculations and Reports screen
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Loading the case file
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	At start-up, the system defaults to an empty participant case file, so that if you were creating a new participant case now, you could start right in on button #2.  But since we want to revisit an existing case, select button #1 instead.

	A few items that may be common to most or all the participants you run may not be reset with a New case (e.g., the Type of Organization \Relate "HELP403.DOC!70", "Type of Organization"  field, and the employer contribution formula); this depends on your Configuration settings.." 
	As soon as you click button #1, you will see the Open Participant Data File screen \Relate "HELP403.DOC!24", "Open Participant Data File screen" .  If you had been running another case and now wanted to clear your inputs for a new participant, you’d click on the New button. \Relate "HELP403.DOC!28", "New button."   Here, however, since we want to retrieve an existing file, we’ll take a different approach.  Just click “NEW Sample” in the File Selection field \Relate "HELP403.DOC!25", "File Selection field" , then click the OK button.


Figure 3: Open Participant Data File screen
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Note that the "File Detail" button will list existing files by participant name instead of by file name.

Having exited the Open Participant Data File screen, \Relate "HELP403.DOC!24", "Open Participant Data File screen,"  you will find yourself back at the Run Calculations and Reports screen. \Relate "HELP403.DOC!17", "Run Calculations and Reports screen."   As you can see, this is your main navigational screen for the system.
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	As you may also notice, there are two small differences in the screen now.  First, the participant’s name appears in the top title bar — in case you forget where you are!  Second, the #2 button is highlighted for you.  All you have to do to go to the next step is to hit the enter key (or click the #2 button \Relate "HELP403.DOC!19", "#2 button" , or type the number “2”, or the letter “E”).


Participant and employer information

Before we delve into the next screen, let’s take a look at our sample case.  Here’s some of the basic information about our sample participant:

	.
	  Participant name:  Oscar Sample
  Date of birth: 7/3/1955
  Tax year:  January to December
  Year being calculated:  2015
  Other relevant employment income:  None
  Occupation:  Middle school principal
  Years of service: 21-1/4 as of December 2015
  Salary:  $54,500 for the 2015 tax year


The following screen shows how this information is entered on the Participant and Employer Information screen, \Relate "HELP403.DOC!52", "Participant and Employer Information screen,"  which will have popped up for you after you hit button #2 on the previous screen.  If you are using Basic Input Mode, the screen will be a little simpler in appearance.

Figure 4: Participant and Employer Information screen
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Given this participant's data, it’s pretty clear where to put each item on the Participant and Employer Information screen. \Relate "HELP403.DOC!52", "Participant and Employer Information screen."   The first time through, it would be a good idea to use the tab key to step through each field and, as you do so, press the F1 key to see the Help entry for that item.  In case you don’t have a chance to do this, though, here are a few tips and cautions:

· Enter the participant’s name exactly as you want it to appear on the report.

· The tax or plan year \Relate "HELP403.DOC!65", "tax year"  is a key item if the participant is just turning 50, because eligibility for the extra contribution allowance for people age 50+ applies to those who turn 50 during the tax or plan year.  Whether the tax year or plan year is used is up to the plan sponsor, as provided in the Job Creation and Worker Assistance Act of 2002.  However, all data entries that relate to dollars refer to the tax year, not the plan year, the calendar year (or the academic year).  This is so important to keep in mind that reminders are scattered around the system.

· Availability of the special $3,000 catchup for employees with 15 or more years of service is the default, but starting in 2009, some plan sponsors have disallowed the use of this option.  In such cases, you can click this item off.

· The dropdown list for the Type of Organization field \Relate "HELP403.DOC!70", "Type of Organization field"  has an odd assortment of six categories, then the seventh is a catchall.  This is because there are special rules that apply to the six itemized types.

· Years of service means full years of service full time, or the equivalent measure in full time years if the participant is working or has ever worked for this employer part time or for a partial year.  It means years of service through the end of the current tax year.  There are other rules as well.  The 403(b) Contribution Planner® will, when it recognizes that there might be a complication, try to help you come up with the right figure here, but it’s a good idea to look at the on-line Help for this field so that you are clear on what the IRS means by Years of Service.  An explanatory window pops up when you go to this field, to remind you of certain relevant factors.  You can, if you like, click the Work History button (not available in Basic mode) to pop up a small spreadsheet to help you determine total years of service and gross compensation; this feature is helpful mainly when the participant has a complicated history that includes part-time service.

· There are also some complications for the Gross Compensation field. \Relate "HELP403.DOC!83", "Gross Compensation field."   This entry must be adjusted if the participant is working less than a full year full time in the tax year in question.

· If you enter Gross Compensation on a monthly or other basis, make sure you set the Gross Compensation Mode field \Relate "HELP403.DOC!86", "the Gross Compensation Mode field" , immediately beneath the dollar entry (not available in Basic mode), to the matching frequency.  An annual frequency is the default setting.

When you have reviewed the entries on this screen, click the OK button.  You will then be returned to the Run Calculations and Reports screen.

Next, we need to look at the participant’s qualified retirement plans.  Here are the facts in this sample case:

  403(b) Plan:
       Includes life insurance:  No
       Employer contributions:  50% of participant contribu-

     tions, up to 20% of gross compensation
  Plan contributions:
       Prior contributions to this plan, by participant:  $74,500
       Prior use of Catchup Provisions:  None
       Other current def. contr.  plan, by participant:  $600
       Other prior def. contr.  plan, by participant:  $6,200
       Other current def. contr. plan, by employer:  $1,200
  Defined Benefit plan employee contributions:  5%
Benefit plans
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	Some of this information goes directly onto the Benefits screen \Relate "HELP403.DOC!108", "Benefits screen" .  You get to this screen by clicking the #3 button on the Run Calculations and Reports screen. \Relate "HELP403.DOC!17", "Run Calculations and Reports screen." 


As you can see in Figure 5, prior year contributions to the 403(b) plan being calculated go in the middle section of this screen.

Figure 5: Benefit Plans screen
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	The All Contributions by Salary Deferral check box is on by default, since most 403(b) plans are set up that way; employer contributions are the exception, though a reasonably common one.
	What is not immediately apparent is that information about employer contributions goes on the Employer Contributions screen \Relate "HELP403.DOC!126", "Employer Contributions screen" , which pops up when you click the All Contributions by Salary Deferral check box \Relate "HELP403.DOC!111", "All Contributions by Salary Deferral check box"  off.  Since it is already off when you first see it in the sample case, you have three ways to pop up the detail screen.  One is to click the check box on, then off again.  Another, which is a good technique to use when reviewing old cases, is to use the tab key.  As you tab onto then off a field, any required popup screen will come into view, regardless of whether it’s an “on” or “off” condition that triggers the popup.  The third way, which works for most screens, is to click the "Window" item on the menu bar, then select the screen you want from the dropdown list.


Employer contributions

Figure 6: Employer Contributions screen
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	If the employer contribution formula does not fit any of the provided methods, you can treat the employer and participant contributions as two separate plans (which they may, in fact, be), and calculate the contribution limits as two distinct cases. \definition "contribution formula" 
	On this screen, you select the appropriate entry from the top panel — in this case, that employer contributions are in addition to participant contributions.  If and only if this option is selected at the top, the bottom panel becomes enabled for your input.  This, as you can see, is where the employer contribution formula goes.  (Note that there is also a check box enabling you to indicate if a match is going to a 401(a) or other non-403(b) plan!)  When you click the OK button, you return to the Benefit Plans screen \Relate "HELP403.DOC!108", "Benefit Plans screen" , where unfinished business remains.


We have now seen all the input except the information about the other qualified plans this employer provides.  A separate detail screen is available for Defined Contribution plans.  Clicking the check box near the bottom of the Benefit Plans screen (or tabbing through it or selecting it from the "Window" menu) pops up this screen.

Defined contribution plans

Back at the Benefit Plans screen, click the Defined Contribution Plans check box (toward the bottom of the screen) off and then on again to pop up the Defined Contribution Plans screen..

Figure 7: Defined Contribution Plans screen

[image: image12.png]Projected TOTAL This
participant VOLUN- Employer
TARY contributions

being made in the  [RUTXT]

curtent tax year

[CLCEUECIN voluntary contibutions in PRIOR years to plans
Roth offered by this employer (excluding 457 plans or

contributions to THIS 403(b) plan)

Projected TOTAL
EMPLOYER Con- This
tibutions to these Employer
plans during the $71200.00
current tax year:

Mandatory incl.
“Picked up”
employee contri-
butions to Defined
Contribution plans
(only)

This
Employer

Reminder: you can click on an item, then
bress the <F1> key for help!

Any Other
Employers

$/6200.00





This screen asks for any information needed about participant and employer contributions to other defined contribution plans.  The current full year (actual year-to-date plus any anticipated contributions, if appropriate) goes on the top, with the total for all prior years in the middle.  The bottom row is used for public retirement systems or other plans that mandate employee contributions to a Defined Contribution plan (available in Basic mode with less detail).  However, keep in mind that this is for Defined Contribution plans only.  If there are mandatory contributions to a Defined Benefit plan, those go at the bottom of the Benefit Plans screen.

When you enter a value for the current year, an input window will pop up asking if any of the contributions pertain to another 403(b) plan offered by the same employer.  If the answer is zero, as it usually is, just click the OK button.

Contributions to plans sponsored by other employers can be input only in cases where this information is required.

The Results
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	Now that all the input is in, you’re ready to check out the results.  Just click button #4 \Relate "HELP403.DOC!21", "button #4"  on the Run Calculations and Reports screen, \Relate "HELP403.DOC!17", "Run Calculations and Reports screen,"  and the system will immediately calculate the contribution limits and display them on the Summary of Recommendations screen. \Relate "HELP403.DOC!37", "Summary of Recommendations screen." 


Figure 8: Summary of Options screen
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	The Summary of Options screen \Relate "HELP403.DOC!37", "Summary of Recommendations screen" , as you can see, is just what its name implies.  The primary recommendation appears at the top, with any other recommendations, in decreasing order of enthusiasm, listed below.  All valid options appear — if it isn’t there, it’s not available.  In most cases after 2001, as in the sample case, only one option is available.


Previewing and Printing the Participant report

If you click the View Report button, \Relate "HELP403.DOC!35", "View Report button,"  you will get a screen preview of the report.  You can double-click your left mouse button to make the print appear larger, or your right button to make it smaller.

Figure 9: Print Preview screen
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You can use the navigation buttons at the bottom left to move from page to page.  The Print to Printer button will immediately print a complete copy of the report.  You can also use the Print to File button to send a copy to a disk file.  Use the Close Preview button to return immediately to the Summary of Recommendations screen. \Relate "HELP403.DOC!37", "Summary of Recommendations screen." 
Note that different versions of the system default to more summarized or (as in the illustrated case) more detailed reports.  You can choose a different type of report by selecting the "Print" menu option on the menu bar that is available from the Summary of Recommendations screen \Relate "HELP403.DOC!37", "Summary of Recommendations screen"  and from several other screens.  The Print menu item \Relate "HELP403.DOC!10", "Print menu item"  offers several choices; selecting "Participant report" brings up the Print Utility screen, \Relate "HELP403.DOC!39", "Print Utility screen,"  which offers options to print, preview, or print to file, \Relate "HELP403.DOC!44", "options to print, preview, or print to file,"  and which also gives you three levels of detail \Relate "HELP403.DOC!40", "three levels of detail"  to choose from.

Which level you choose depends largely on what you plan to do with the output.  But it is recommended that you print at least one detailed copy for your files.  This will help justify the results in case of an IRS audit, or in the event some other question arises.  We also recommend that you leave the "Also print participant input assumptions" option selected when you create your file copy.

Clicking the OK button on the bottom of the Summary of Recommendations screen \Relate "HELP403.DOC!37", "Summary of Recommendations screen"  will return you to the Run Calculations and Reports screen. \Relate "HELP403.DOC!17", "Run Calculations and Reports screen." 
Saving the data
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	Back at the Run Calculations and Reports screen, \Relate "HELP403.DOC!17", "Run Calculations and Reports screen,"  you should normally save your data for possible future reference.  Much of the data you enter this year will still be relevant next year.  Use the #5 button \Relate "HELP403.DOC!22", "#5 button"  to Save the data.


If you are updating an existing file, as in this case, the system will just quietly save the file.  But if this were a new case that had not yet been saved, or if you used the File / Save As menu option \Relate "HELP403.DOC!15", "File / Save As menu option"  to save the data under a different name (or, perhaps, under the same name but on your A: drive so that you can transfer it to another computer), the Save Participant Data to File screen \Relate "HELP403.DOC!31", "Save Participant Data to File screen"  would appear.

Figure 10: Save Participant Data to File screen
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	The case is now complete.  

After the Save Participant Data to File screen, the system will immediately prompt you to open another case.  You can click "New" to clear all the fields for brand new input, or you can select an existing file to open.  Or you can "Cancel" to return to the Run screen.  Button #6 \Relate "HELP403.DOC!23", "button #6"  on that screen returns you to the Main Options screen. \Relate "HELP403.DOC!6", "Main Options screen." 


Note that you can use the File / Exit menu option to exit the system directly, at any time.

And now you’re ready to try your own, real-life case!

For Doctors, Professors, and others....

...who have self-employment income in addition to their income from an employer offering a 403(b) plan:

The 403(b) Contribution Planner® can help.  It calculates the maximum 403(b) contribution taking into account the special plan aggregation rules that apply in these cases.

It does not do the reverse, however: it will not calculate the maximum permissible contribution to a Simplified Employee Pension plan (SEP) or a Keogh (HR-10) plan, for instance.  The best approach, where such plans are in place, therefore, is to determine the maximum contribution to these plans first, without regard to the 403(b) plan.  Then use the 403(b) Contribution Planner® to determine how much, if any, can be contributed to the 403(b) plan over and above the other plan.  You do this by entering the SEP or other employer contributions on the Defined Contribution Plans screen, \Relate "HELP403.DOC!148", "Defined Contribution Plans screen," .  Starting in 2000, the tax code no longer requires aggregation of 403(b) with defined benefit plans.

State Retirement Plan Benefit calculator

You can use this utility, available on the main screen and under the "Tools" menu option, to calculate benefits under many retirement systems.  You can also print out a one-page report summarizing the results.  Retirement does not have to occur at the normal retirement age; early retirement penalties, if applicable, will be estimated.  Most people find the input screen to be self-explanatory, but you may always use the F1 key for detailed help.

Years-of-Service Buyback Calculator

Does it make sense for a public retirement plan participant to buy extra years of service credit under that plan in order to increase his or her pension?

On the main screen, and also under the Tools menu, you will find "Buyback Years of Service."  Click this option to enter the Buyback calculator.  This input screen is similar to the State Retirement Plan Benefit calculator screen, and you may use the F1 key for detailed help.

Paycheck Comparison

Figure 11: Paycheck Comparison
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On the main screen, as well as under the Tools menu item, you will find the Paycheck Comparison.  This feature illustrates the effect on take-home pay when the participant's 403(b) contribution amount changes (or, conversely, the amount of pre-tax contribution the participant can make in order to produce a stated amount of take-home pay).

Although this calculation cannot be completely accurate without much more detailed knowledge of the participant's tax situation and the employer's payroll practices, the 403(b) Contribution Planner® provides a solid estimate, taking into account federal, state, and local taxes as well as FICA taxes and other payroll deductions.

The Paycheck Comparison can be used live on the screen and/or in a hardcopy version.

Note that some versions of the system may have a different kind of Paycheck Comparison.  In those cases, open up the Parycheck Comparison screen and use the <F1> key for further information. \Relate "HELP403.DOC!163", "Benefit Plans Aggregation screen." 
Retirement Planning Presentation

Figure 12: Retirement Planning input
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On the main screen, and under the Tools menu item, you will find the Retirement Planning Calculation.  This feature illustrates how much you need to save monthly to reach your retirement goals.  There is no way to be certain, unless you can predict how long you will live and what will happen with interest rates, tax rates, inflation, etc., but at least the guess can be an educated one.

You can then print a 6-page color presentation that explains the calculation and the advantages of 403(b) contributions.

Section 457 Contribution Calculator

Figure 13: 457 contribution limit  input
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In most versions of the system, on the main screen and under the Tools menu item, you will also find a utility that calculates Section 457 maximum contributions.  It works for years after 1999, and uses the appropriate rules and limits for each year.

Retirement Plans Contribution Wizard
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The Wizard is available from the main screen and from the Tools menu.  It provides an objective way of evaluating whether a client should put money into a 403(b), 457, IRA and/or Roth IRA plan, depending on which plans s/he may be eligible for, and on the answers to half a dozen questions about beliefs and preferences that affect the decision.

For detailed help, open up the Wizard in the system, then hit the <F1> key.

Asset Accumulation illustration

Figure 14: Asset Acculuation input
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The Asset Accumulation illustration can be reached from the main screen or from the Tools menu.  It shows you how a given account balance, augmented by future contributions at a fixed or increasing rate (including employer contributions, if applicable), would grow over time at a hypothetical rate of return.  This utility is available in most versions of the system.

For detailed help, open up the utility and press the <F1> key.

Distributions calculator

Figure 15: Retirement Planning input
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On the main screen and under the Tools menu, you can choose to calculate distribution options, in most versions of the system.  This screen enables you to determine either required minimum distributions or substantially equal periodic payments for early withdrawals (so-called 72(t) distributions).  Both calculation types allow you to calculate the full range of legal options, and can even print comparison reports to help you and your client select the best available option.  Use the F1 key frequently for help on this screen, since there are a number of technicalities that are not completely obvious!

Common Questions and Problems

Input (General)

1. When should I use the Advanced input mode?

On the “Run Calculations and Reports” screen, where you can switch from Basic to Advanced mode, there is a list of reminders at the bottom of the screen. The most common and important exceptions, when you should use the Advanced mode, are (a) when the participant has his or her own pension plan through self-employment, in addition to the 403(b) plan; or (b) when there is another 403(b) plan offered by the same employer.  But there are other situations as well; refer to the list on the screen.


2. Sometimes the system fills out certain input fields (such as compensation) automatically for me, but when I make changes it doesn’t update them.  Why not, and what should I do about it? 

The system tries to help you by filling in some of these items when it can.  However, it only does it when it knows that it can.  If the field is blank, then the system may figure that it can update it.  But if it’s not blank, then the system isn’t sure: is that an old number that needs to be updated, or is it a special situation where you entered the number and that’s what you want it to be?  When it can’t tell the difference, it leaves numbers the way they are.  So you need to be extra careful to look at all the fields when you’re revising data for an existing client.  The system will still try to help you: if you change the years of service or the gross compensation on the “Participant & Employer Input” screen, the system will warn you if you try to save the file without updating corresponding information on other screens; but it still won’t automatically change them for you.


3. I got an error message I didn’t understand.  When I tried to continue running the system, it shut down and I lost my data.  What happened? 

You found a bug in the system.  This shouldn’t happen, but once in a while it does.  Please report this error — it may be something that someone else has already encountered, and there may be an easy way around it.  Occasionally, however, such problems are connected with the way your particular system is configured, and we may not be able to correct it.  But we will work with you directly, if necessary, to see if the problem can be resolved.


4. What do I have to do different for church employees? 

When you indicate on the “Participant and Employer Information” screen that the participant is employed by a church organization, some new options open up.  On the Benefit Plans screen, you need to indicate if the participant has used any of the special $40,000 lifetime allowance for church employees under Section 415.  The system will calculate the special church allowance separately and both display and print the result as a distinct contribution option.


Input (Participant & Employer Information)

5. What do I put in the Optional ID field? 

Generally, you can skip this.  If you are planning to run reports for a large body of participants from the same employer, however, and you need to link your individual calculations with data files downloaded from the employer’s compensation systems, then it will be helpful to have an ID for each person.  Normally this would be a Social Security Number, or an employer ID provided by the employer.


6. When should I use the optional file directory field? 

This field appears on some versions of the system.  Use it when and if you want to keep participant data separated by employer.  This is a good idea if you do lots of calculations and have clients who work for different employers.  It’s a definite requirement, however, only if you plan to import individual data into a batch (that is, a group) run.  In that case, you must keep individual data files segregated in different subdirectories.


7. If I try to run calculations for prior tax years, will the system follow the proper rules that were in effect that year, or do I have to make some kind of adjustment? 

Yes, the calculations will reflect the rules in effect for the year selected.  The users guide does not explain the input for pre-2002 cases, but there is extensive on-line help.


8. If the participant has self-employment income, do I always have to use the Advanced input mode so that I can enter it on the “Participant and Employer Information” screen? 

No.  Self-employment matters only if the participant contributes to other qualified defined contribution plans (such as SEPs, or some Keogh plans) through employment he or she controls.  Special rules apply here which may tend to reduce the permissible 403(b) contribution.


9. What do I do differently if the participant works only part-time? 

First, click off the check box that says “Working full time for the full tax year.”  When you do this, the “Part of a Year and/or Part-Time Work” screen pops up.  Fill it in completely.  When you enter the actual gross compensation at the bottom of this pop-up screen, make sure it is the compensation paid during that 12-month period only.  Second, when you get back to the “Participant and Employer Information” screen, you need to make sure that under “Years of Service” you enter only full-time equivalent years (i.e., someone working half-time for 6 months is credited with only ¼ year of service for that 12 months).  Finally, when you enter “Gross Compensation” on that screen, you enter compensation for the last full-time equivalent year, not the last actual tax year; to follow the same example, if someone had consistently worked half-time for six months of each year, you would need to add up compensation from their last four years of service to equal the equivalent of one full year of full-time service; if there are mandatory state retirement plan contributions, a place is provided to enter the actual amount contributed during the 12-month period (again, not including any prior time periods, as you would do on the Benefit Plans screen.  In Advanced input mode, click the optional Work History button for a worksheet that will allow you to enter the compensation history and calculate years of service and gross compensation for you.  Use the on-line help for a more detailed explanation.


Input (Benefit Plans Information)

10. How do I handle employer contributions to the plan? 

On the “Benefit Plans” screen, click off the check box that says “All contributions are by salary deferral.”  When you do so, the “Employer Contributions” screen will pop up.  You have a variety of choices for the employer contribution formulas; if you need more information on them, you can press F1 for help.  If the employer contributions are actually going into a different 403(b) plan, however, you should use the Advanced input mode, then go back to the “Benefit Plans” screen and click the check box that says “Any employer offers any other Defined Contribution plan”; when you do so, the “Defined Contribution Plans screen” will pop up, and you can enter current and prior contributions to the other 403(b) plan on the appropriate lines on that screen.


11. What do I do if there’s a Section 457 plan? 

Starting in 2002, Section 457 plans and 403(b) plans have entirely separate contribution limits, with contributions to either type of plan having no effect on the other.  Prior to 2002 this was not the case, however, and so for those years you need to use the Advanced input mode to handle such situations.
 

Calculation Results

12. Is there any way I can add text (e.g., additional disclaimers, or information about our organization) to the report? 

You have two options.  If you click the “Configuration” option on the menu bar, the Configuration screen will pop up.  The last two items on that screen allow you to add your own verbiage, which will appear at the end of the participant reports.  Use the Windows Notepad program to create a file called “FOOT403.TXT” in your “\403” directory; enter the text you want into this file.  This text will appear on all future reports you run.  The other option, which may be better if you need to add comments only once in a while, is to use the “Print / Participant report” option on the menu bar to call up the “Print Utility” screen.  On that screen, you can request output to a text file, instead of to the printer.  Then you can open up your text file using just about any word processor and make whatever edits you need, but you need to do it separately for each participant!


13. How can I send output to a different printer? 

Use the Print menu to print your report.  On the Print Utility screen you may select a different printer.


14. The IRS Publication 571 Worksheet report gave me a different answer than the regular participant report.  How come? 

The IRS Publication 571 Worksheet duplicates the calculations you would get if you filled out that worksheet by hand.  However, that worksheet is incomplete, and does not always give the correct answers.  You should never use the 571 Worksheet as a substitute for the regular participant reports that the system produces.


15. The system came up with a different answer than someone else (or some other software package) came up with.  Which one is right?  How can I be sure? 

Print out the detailed report and see if the explanation makes sense.  If you’re still not sure, send it along to us and we’ll verify it.  Make sure you send the Assumptions report, too.  If you can also send a copy of the participant data file, and a copy of any alternative calculations or output from other software, that may help resolve the discrepancy.


16. I got a lot more information in this report than I want.  How can I suppress some of it? 

Choose “Print” from the menu bar at the top of the screen, then select “Participant Report”.  The “Print Utility Screen” will pop up.  In the top section, select “Results only” to obtain the shortest possible version of the report (generally, two pages, plus two pages for the input assumptions, unless you turn off the Assumptions report before clicking the “Go” button).


Multiple Runs

17. Can I save participant data for later use? 

Yes.  Click button #5 on the “Run Calculations and Reports” screen (or use “File / Save” on the menu bar).  The “Save Participant Data to File” screen will pop up.  Enter a file name and click the “OK” button.  The system will save each set of participant data in a separate file. 


18. How do I get participant data that I saved previously, and how do I update it without losing the old data? 

Click button #1 on the “Run Calculations and Reports” screen (or use “File / Open” on the menu bar).  The “Open Participant Data File” screen will pop up.  Select the file you want; you may have to select a different directory or subdirectory first, if you are putting data files in various directories.  If you click the “File Detail” button before selecting a file to open, you will get a list of participant names and dates rather than a list of file names.  After you’ve opened the file and updated the data, if you want to save it without over-writing the old data, use  the “File / Save As” option on the menu bar (do not use “File / Save” or the #5 button); just make sure you give the new file a different name, or put it in a different location.


19. Is there any way to run calculations for multiple participants all at once, or without having to manually enter all the data? 

Actually there are two ways.  If you create individual files for different participants, you can then select "Multi-print" from the Print menu, and select those files that you want and print them all at once.  You can use the mutli-print feature for 403(b) reports or for any of the utility reports.  Still River also offers a separate program called the “Batch Processing Utility” that handles 403(b) calculations for large groups, where you want to input data from an outside source and/or you want to produce a summary report for the entire group.  It is more difficult to use, however, and requires special instruction; therefore it is not distributed with the regular system, but only by special arrangement.


Where to Get Help

On-line Help

There is thorough on-line documentation for the 403(b) Contribution Planner®.  This is the best place for you to get help.  From just about any place in the system, you can press the F1 key, which immediately takes you to information pertinent to the field that’s currently in focus.  (You can move the focus to most fields by clicking on them.  For check boxes, you may prefer to use the tab key to move the focus, then press F1 when you get where you want to be).

Help screen terms that have solid green underlines are “jumps;” if you click on one of them, you are taken directly to another Help screen that relates to that topic.  Terms with dotted underlines are glossary terms; if you click on one, a definition will pop up, but the Help screen you were reading does not go away.

The system has a different help file for cases before 2002.  Using the F1 key, therefore, will call up different help, depending on whether your case is for a year before 2002 or a year after 2001.
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	The on-line help Contents button takes you to the on-line Table of Contents.  These contents include not only the manual you are reading, but detailed help for every screen and field that appears in the system.  Clicking on "Table of Contents" items will expand those items to include relevant sub​topics.  At the lowest level of detail, clicking on the entry takes you to the Help screen for that item.
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	The on-line help Search button is your door to the alphabetical index of on-line Help topics.  “Search” is often the best way to find what you want.
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	The on-line Glossary button takes you to an on-line copy of the same glossary that appears as an appendix to this User’s Guide.

	Help
	You can also get to on-line Help by clicking the Help menu item \Relate "HELP403.DOC!11", "Help menu item"  on the system’s Menu Bar. \Relate "HELP403.DOC!5", "Menu Bar."   This button takes you to the Table of Contents.  Note that the Help item on the help window's menu bar gives you more detailed help on how to use Help!


If you still need help, contact us

....or if you've discovered a bug!

Still River Retirement Planning Software, Inc.

69 Lancaster County Rd.

Harvard, MA  01451

(978) 456-7971

Fax: (978) 456-7972

E-Mail: csy@StillRiverRetire.com

For more information about 403(b) plans

Consult the Bibliography \Relate "HELP403.DOC!55", "Bibliography"  that follows for a current list of expert sources we’ve taken advantage of in developing this system.

Appendix

License Agreement

STILL RIVER 403(b) CONTRIBUTION PLANNER® — SOFTWARE LICENSE AGREEMENT

THIS IS A LEGAL AGREEMENT BETWEEN YOU AND STILL RIVER RETIREMENT PLANNING SOFTWARE, INC. (“STILL RIVER”).  CAREFULLY READ ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT BEFORE USING THE STILL RIVER 403(b) CONTRIBUTION PLANNER®.  UNLESS YOU HAVE REQUESTED AND OBTAINED A DIFFERENT WRITTEN LICENSE AGREEMENT SIGNED BY AN AUTHORIZED OFFICER OF STILL RIVER, YOUR USE OF THE STILL RIVER 403(b) CONTRIBUTION PLANNER® INDICATES YOUR ACCEPTANCE OF THIS LICENSE AGREEMENT.  IF YOU WISH TO REJECT THIS LICENSE AND TO RECEIVE A FULL REFUND OF THE PRICE YOU HAVE PAID FOR THIS SOFTWARE: DO NOT USE THE SOFTWARE, AND WITHIN 30 DAYS OF DELIVERY OF THE SOFTWARE TO YOU, RETURN ALL OF YOUR COPIES OF THE SOFTWARE TO STILL RIVER, ALONG WITH YOUR INVOICE AND YOUR WRITTEN CERTIFICATION THAT THE SOFTWARE HAS NOT BEEN USED.
Still River grants you a personal, non-exclusive, nonassignable and non-transferable license to use and display the Still River 403(b) Contribution Planner® software (the “Software”) and related Still River documentation in the United States of America.  Still River retains title to the Software (including all copies), regardless of the form of media on which it is contained, and to all copyrights, trade secrets and other rights and interests therein.  The Software and accompanying written materials are protected under copyright, trade secrecy and other applicable laws.  You may not copy, reproduce or transmit (including, without limitation, electronic transmission over any network except, in the case of an Unrestricted Site License, for a local area network serving one office) any part of the program.  However, you are permitted to transfer the program to a single computer hard disk and to keep the original copy as a back-up.  You may also make one copy of the Software solely for backup or archival purposes.

The Software is licensed in four versions.  If you have acquired an Unrestricted Site version or a Plan Sponsor's version, you may use the Software for an unlimited number of occasions on an unlimited number of personal computers located within (or on laptop computers for employees based at) a single office at a single address.  If you have acquired a Professional Adviser’s version, you may use the Software on up to 75 occasions each on two computers.  If you have acquired a Personal version (or a “Demo” version), you may use the Software on up to ten occasions each on two computers.  THE SOFTWARE MAY CONTAIN TIME AND DATE DEPENDENT PASSWORDS DESIGNATED BY STILL RIVER, AS WELL AS OTHER MECHANISMS, INTENDED TO DISABLE THE SOFTWARE’S USE OTHER THAN AS PERMITTED HEREUNDER.

You may not sublicense, assign or transfer the Software except as permitted by Still River.  Any attempt to sublicense, assign or transfer any of the rights, duties or obligations under this Software License Agreement is void.  You may not lease, rent, modify, merge, reverse engineer, decompile or disassemble the Software or any portions thereof. You may not remove, obscure or alter any notice of copyright, trademark, trade secret or other proprietary rights in the Software or any related documentation.

Without limiting Still River’s other rights or remedies, the license will terminate automatically without notice from Still River if you fail to comply with any provision of this license.  Upon expiration of the term of this Agreement, you agree to promptly return the Software (including all copies) and accompanying documentation to Still River at its principal place of business.

Still River has made reasonable checks of the Software to confirm the compliance of its assumptions with accepted interpretations of applicable federal income tax laws and regulations currently known to Still River.  Still River also has made reasonable checks of the Software to confirm that it will perform in normal use on compatible equipment.  Because the Software prepares calculations involving tax compliance issues, and because interpretations of tax laws and regulations vary, it is essential that you check the calculations for their accuracy and the validity of their compliance.  Still River also recommends that you have the Software results reviewed by competent tax advisers.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data before relying on it.  THE ENTIRE RISK AS TO THE QUALITY, PERFORMANCE AND USE OF THE SOFTWARE IS BORN BY YOU, and you agree to indemnify and hold harmless Still River and its suppliers from all claims, losses, liabilities, costs, damages and other expenses arising from any use of the Software or related documentation, or from any breach by you of this Agreement.

Still River does not warrant that the Software or related documentation is error-free, or that it will operate without interruption or that it is compatible with all equipment and software configurations, or that it will otherwise meet your needs.  THE SOFTWARE AND RELATED DOCUMENTATION IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND (INCLUDING WITHOUT LIMITATION THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT) OTHER THAN THOSE WARRANTIES WHICH ARE IMPLIED AND INCAPABLE OF EXCLUSION, RESTRICTION OR MODIFICATION BY APPLICABLE LAW.  ANY SUCH IMPLIED WARRANTY WILL TERMINATE UPON THE EXPIRATION OF 30 DAYS FOLLOWING DELIVERY OF THE SOFTWARE TO THE CUSTOMER.  AS YOUR SOLE REMEDY FOR ANY BREACH OF WARRANTY, you may return to Still River the original copies of the Software and all related documentation, along with proof of purchase, any backup copies and a copy of the illustration or other output showing any Software error you have found, for replacement or (at Still River’s choice) for a refund of the amount you paid, provided that the return is completed within thirty days following Software delivery to you.  Some states do not allow either the exclusion of implied warranties or limitations on how long an implied warranty may last, so the above limitations and exclusions may not apply to you and you may have other legal rights that vary from state to state or by jurisdiction.

IN NO EVENT WILL STILL RIVER BE LIABLE FOR ANY DAMAGES IN EXCESS OF THE PRICE YOU HAVE PAID FOR THE SOFTWARE, OR FOR ANY CLAIM BY ANY OTHER PARTY.  In addition, UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, TORT, CONTRACT OR OTHERWISE, SHALL STILL RIVER (OR ITS SUPPLIERS OR RESELLERS) BE LIABLE TO YOU OR ANY OTHER PARTY FOR ANY INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE OR RELATED DOCUMENTATION, INCLUDING WITHOUT LIMITATION DAMAGES FOR LOSS OF INCOME, USE OR INFORMATION.  Some states do not allow the limitation or exclusion of liability for incidental or consequential damages, so the above limitation or exclusion may not apply to you.

This Agreement is governed by Massachusetts law and will be enforceable by (among other remedies) injunctive relief.

The Software and accompanying documentation are provided with RESTRICTED RIGHTS.  Use, duplication or disclosure by the Government is subject to restrictions as set forth in the appropriate subparagraphs of the Commercial Computer - Restricted Rights clause at 48 C.F.R. 52.227-19, or in the appropriate subparagraphs of The Rights in Technical Data and Computer Software clause at DFARS 252.227-7013, as applicable.  The contractor/manufacturer is Still River Retirement Planning Software, Inc., 69 Lancaster County Rd., Harvard, MA 01451.

Still River Retirement Planning Software, Inc.

69 Lancaster County Rd., Harvard, MA 01451

(978) 456-7971

Glossary of Terms\Gloss
Aggregation

The combination of qualified plans for purposes of testing their joint status under the Section 415 limits.  In most cases, 403(b) plans do not have to be aggregated with other plans, but exceptions occur when the participant has qualified plans sponsored through self-employment or controls the employer offering the 403(b) plan

Annuity Contracts

This is a technical term in the tax code.  It refers not to annuities as financial products, but rather to qualified plans generally.  The reason, apparently, is that the ultimate intent of these plans is to pay a retirement benefit, which may be considered an annuity.

ASCII files

ASCII is the standard format for storing computer data (although many others are used).  ASCII files can be read by any text editor (such as Windows Notepad) and by any word processor.  The 403(b) Contribution Planner® uses ASCII files for both participant data and print files.

Church Limits

Employees of churches and church-related organizations are eligible not only for the same special Catchup Provisions offered to certain other types of employees, but also for unique exceptions under both section 403(b) and the Section 415 limit.  These exceptions are moderately complex, and can be found in IRC 403(b)(2)(D) and 415(c)(7).

Controlled Employer

see: Self Employment

Defined Benefit plan

A tax-qualified pension plan in which the amount of the retirement benefit is defined by some formula (typically involving age, salary, and years of service, among other factors).  The employer is usually responsible for assuring that sufficient funds are available to pay the retirement benefit.

Defined Contribution limit

see Section 415 limit

Defined Contribution plan

A tax-qualified pension or profit-sharing plan in which contributions are made by the employer and/or employee and accumulate on a tax-advantaged basis.  The retirement benefit is not fixed in advance, but depends upon the account balance.

Effective Year

The specific 12-month period (months and year) for which contribution limits are being calculated.  The months covered by the effective year should coincide with the participant's Tax Year.

Elective Deferral limit

"Elective Deferrals" is the IRS' term for a participant's voluntary pre-tax contribution to a qualified plan.  Section 402(g) of the Internal Revenue Code limits these deferrals, and 403(b) contributions made by salary deferral are subject to this limit, in addition to the Exclusion Allowance and the Section 415 limit.  Starting in 2006, the same limit covers Roth-type contributions to defined contribution plans.

Elective Deferral Limit for Long-Term Employees

A special increase in the Elective Deferral limit applies to participants with 15 or more years of service with their current employer.  The (inflation-adjusted) $10,00 limit is increased up to $3000 per year, subject to certain additional tests, including a $15,000 lifetime limit in the use of these special increases.

Exclusion Allowance

The maximum 403(b) contribution that can be excluded from the participant's income as determined under Section 403(b).  Starting in 2002, the Exclusion Allowance is the lower of the amounts permitted under Section 402(g) [the Elective Deferral limit] and Section 415.

IRS Annual Limits

Numerous qualified plan limits are subject to annual inflation adjustments; five of them can potentially affect 403(b) plan contribution limits.  The IRS usually announces the revised limits for each year sometime around November 1 of the preceding year.

Main Options screen

This is the first screen you see when you start up the system.  It contains five function buttons and a menu bar.  The Run Calculations and Reports button \Relate "HELP403B.DOC!0", "Run Calculations and Reports button"  takes you deeper into the system so that you can input, calculate, print and save data.  The Exit button \Relate "HELP403B.DOC!1", "Exit button"  takes you out of the program.

Menu Bar

The Menu Bar, which appears at the top of several screens, offers six menu options: File, Print, Configure, Tools, Window, and Help.  Click on any one of these for a dropdown list offering further options or, in the case of the Configure menu option, to be taken directly to the configuration screen.  The menu bar is available from the principal navigation screens, but is not available (even though it may be visible) from the detail screens.

Plan Year

The calendar, policy, or fiscal year on which the records of the plan are kept.  Each plan may elect its own plan year.

Qualified Plans

Pension or profit-sharing plans that are regulated and approved under the Internal Revenue Code and therefore "qualify" for favorable tax treatment.  Qualified plans are either Defined Benefit plans or Defined Contribution plans.  Section 403(b) plans are qualified Defined Contribution plans.  Technically, 403(b) plans are not qualified plans, but they have most of the same attributes as qualified plans and so are usually lumped in with them.

RTF

Rich Text Format.  This is a Microsoft-defined format for ASCII word processing documents that allows various formatting options to be specified.  Most commonly-used word processors can read RTF documents and will recognize the formatting commands.

Run Calculations and Reports screen

The screen you get when you click the Run Calculations and Reports button (or press R or Alt-R) on the Main Options screen.  The Run Calculations and Reports screen presents six buttons numbered 1 thru 6, which take you through the typical sequence of running a participant’s case.

Salary Deferral

see Salary Reduction (also, Elective Deferral limit)

Salary Reduction

The deferral of an employee's salary or wages directly into a qualified account; such deferrals are made on a pre-tax basis, provided that they fall within the limits specified in the tax code.  This is the standard method of making participant contributions to 403(b) plans.

Section 403(b) plan

A tax-qualified retirement plan (defined in Internal Revenue Code section 403(b)) that permits employees of public schools and certain tax-exempt organizations to contribute, or for such employers to contribute on their employees' behalf, to tax-sheltered accounts.

Section 415 limit

Actually a family of limitations that regulate the amounts that can be contributed to qualified plans.  There is a 100% of compensation limit and a $40,000 (inflation-adjusted) limit for Defined Contribution plans, including Section 403(b) plans.  Additional limits apply when there is a Defined Benefit plan.

Self employment

For purposes of the 403(b) Contribution Planner®, this refers to any employers other than the one offering the 403(b) plan if the participant controls them (i.e., owns over 50%).  This also includes, therefore, any employers related to the one offering the 403(b) plan, if the participant controls them.

Tax Deferred Annuity

Same as Tax Sheltered Annuity

Tax Sheltered Annuity

Common alternative name for a Section 403(b) plan or a product used to fund one; "Annuity" in this context is actually a technical tax term that applies to these plans even if they are funded with mutual funds or life insurance.

Tax Year

The annual twelve-month period used by the participant in declaring personal income taxes.  Most people use the default tax year, which is January-to-December, but a different tax year can be elected.  Note that for most teachers, the tax year is not the same as their employment year (i.e., the academic year), which can complicate calculation of their contribution limits.

Windows

"Windows" is a registered trademark of Microsoft Corporation.  The 403(b) Contribution Planner® will not run if your machine has a version of Windows earlier than Version 3.1.  It should run, however, on Version 3.1 or later versions, including Windows for Workgroups, Windows NT, and Windows 95.

Years of service

Total full-time-equivalent full years of service, for purposes of the 403(b) Exclusion Allowance.  Partial years and/or part-time years count proportionally.
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